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1.1 About this Manual 

This user manual covers the features and components, which make up Zylinc Contact Center. The 
manual serves as an addition to the general manual for Zylinc Desktop Applications, which describes 

the features common for several of Zylinc desktop products. 
 

 

Please note: The manual may differ from your application. 

There may be differences between this manual and your application. This might be the case if you 
are using another version than documented here (version 6.0) or if your administrator has disabled 
features or components. This manual is subject to change without notice and may contain technical 
inaccuracies or typographical errors. 
 

1.2 About Zylinc Contact Center 

Zylinc Contact Center automatically distributes incoming calls from the company’s queues to the proper 
agents. Each agent has an overview of all queues, a graphical representation of each queue's calls as 
well as an overview of the other agents handling calls. These are the main features of the application's 
Contact Center Window and will be further described in this manual addition. 
 
Similar to all Zylinc desktop applications, Zylinc Contact Center provides an overview of all employees 
in the company and includes functions such as searching or sending a phone message. These functions 
are made available through the application's Time window, which can be hidden when not in use. The 
next section summarizes the features available in the Time window. You can find a more detailed 
description in the manual for Zylinc's Desktop Applications. 
 

 
 
 
 
 

 
 

Zylinc Contact Center. 
 

1 Introduction 

The Time window  
(described in the manual for Zylinc's Desktop Applications) 

Contact Center 

Window 
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1.3 Summary of Basic Features 

 

 
 

The Time window in Zylinc Contact Center.  
 

 

1) The Time component 
A list of users and their status. 

Absence (right-click a user) 
Create absence for a user. 

2) User Details 
View info about a chosen user. 

Forwarding (right-click a user) 
Forward a user’s calls to a different phone. 

3) Search 
Search for one or more users.  

Create calendar entry (right-click a user) 
Create a meeting or an appointment with the user. 

4) Calendar 
Choose the date you want to see 
appointments for. 

Find Available Time (open from the Actions menu) 
View a list of timeslots where selected users are 
available for a meeting. 

5) Calendar Details 
View a chosen user’s calendar entries.  

Layouts (open from the Layouts menu) 
Choose the appearance of the application. 

6) Groups 
Users in the system organized in groups. 

Settings (open from the File menu) 
Change application settings. 

7) Send Message 
Send an email or SMS. 

 

 
Please refer to the manual for Zylinc Desktop Applications for a more detailed description of these 
components and features.  
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The Contact Center Window is used to answer and handle calls. The features available in the Contact 
Center Window will be covered in the following sections. 
 

 

 
 

The Contact Center Window. 
 

2.1 Status 

2.1.1 The Status Bar 

Your status determines whether you receive calls. The status bar in the upper part of the window shows 
your status. Section 2.1.2 and 2.1.3 contain more information about the different statuses. 
 

 You are Idle and ready to receive calls. 

 You become Busy when you are offered or handling a call. Your status 

may also change if you become busy elsewhere, e.g. on your office phone. 

 You end up in Wrapup when you end a call. 

 You are idle and Standby. You only get calls if the call situation is critical. 

 You have changed status to Inactive and will not receive incoming calls. 

 If you miss a call or have connectivity issues, your status changes to 
Unreachable. 

 You are Offline and can neither view queues, agents nor take calls. 

 

2 Contact Center Window 

View and 
change 
your 

status. 
Enter a number 
and either dial or 
transfer a call to 

that number. 

Your active 
calls and 

call buttons. Tabs showing 
queues, agents, or 
calls (the image 
shows the Calls 

tab). 

Notification bar. 
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2.1.2 How to Change Status 

Above the status bar (in the top of the Contact Center Window), there are two buttons to change your 
status to either Active, Standby or Inactive. 

 

Status Description 

Active As active, you can be either Idle (green), Busy (red) or in Wrapup (yellow). 

Which status you have depends on whether you are handling a call. If you are 
Idle, you will receive calls as they come in. 

Standby In Standby (orange), you will only receive calls when: 
1. There are too many calls in a queue. 
2. A call has waited in queue for too long. 
3. There are no Active agents subscribed to the queue.  

 
If you start receiving calls from a queue when in Standby, you have become 
activated on that queue. The specific threshold that activates Standby agents 

on a queue depends on the configuration of each queue. 

Inactive As Inactive (gray), you will not receive any incoming calls, but you are still able 

to make outgoing calls. 

 
When you change your status from Active to either Inactive or Standby, you might be asked for a reason. 
This is to let your colleagues know why you changed your status.  
 

 
 
 
 
 

       
 

How to change your status.  
 

 
 
 
 
 
 
 
 
 

1) Click Inactive (or 

Standby) while Active. 

2) Select a reason 

and click Accept. 
3) Click Active to 

receive calls again. 
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2.1.3 Error States 

In case of issues, the system can change your status to either Unreachable or Offline. 
 

Status Description 

Unreachable Your status is changed to Unreachable (black) in cases where you did not 

answer an incoming call or your telephone has connection issues. While you 
have this status, you will not receive calls. 
 
When your status is changed to Unreachable, you get a popup warning wherein 
you can change your status to Active or Inactive. If you do not select anything, 
the system can change your status to Active or Offline after a while, depending 
on your company policy.  
 
Please note that Standby agents will not be activated when you are 
Unreachable. If you need a longer break, you should change your status to 
Inactive to avoid becoming Unreachable. 

Offline If your connection to the system is severed, your status will change to Offline 
(white). When this happens, all agent features are disabled, i.e. you will not be 

able to see calls, queues, agents, or make outgoing calls and other agents will 
not be able to see you. If you become offline while you have an active call, your 
agent phone determines whether the call is lost or kept alive. Please note that 
features and components in the Time window may remain available even when 
you are offline.  

2.2 Active Calls 

When you receive an incoming call, it will appear in the Calls 

tab, where you can answer it. After answering a call, all 
features for call handling can be found in the upper part of the 
Contact Center Window. For example, you can put a call on 
hold, end it, or transfer it to a different number. 
 
While the top of the Contact Center Window is your primary 
way for call handling, the Calls tab gives you information 

about the customer calling. 
 
Depending on how far you are in the call handling process, 
you will see different buttons in the Contact Center Window. 
Please note that you can only handle one incoming call at a 
time.  
 
You can read more about call handling in chapter 3. 

 

 
 

Upper part of the Contact Center 
Window.  

 

2.3 Tabs 

The lower part of the Contact Center Window has three tabs: Queues, Agents, and Calls. If you want 

to view two or all tabs at the same time, you can drag the needed tabs out of the Contact Center Window. 
To restore the tabs, click the X in the right corner of each tab. 
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The three tabs in the Contact Center Window. The Queues tab (on the left) and Agents tab (in 
the middle) are dragged out of the main window (on the right) and have their own separate 

windows, so they all are displayed at the same time.  
 

2.3.1 Queues 

The Queues tab shows the queues' call 

situation in your system.  
 
In the top of the tab, you can choose 
between the three filters: All queues, My 
Queues and Subscribed queues. 

 
Below the filter, you can view your 
personal queue, which shows how many 
calls are waiting for you. The other queues 
displayed in the list depend on which filter 
you choose. 
 
Click Administer queues in the bottom of 

the tab to choose from which queues you 
want to receive calls. 

 
 
 
 
 

 

 
 

The Queues tab. 
 

2.3.1.1 Queue Filters 

Queues can be divided into two: The ones you receive calls from and the ones you do not. The queues 
you receive calls from are your Subscribed queues.  

 
If you do not receive calls from a queue, there are two possible explanations: Either you have actively 
chosen not to receive calls from the queue, or you have no association to the queue and cannot 
subscribe to it.  
 
The three filters All queues, My Queues and Subscribed queues display queues based on your 

association and subscriptions.  
 
 

Choose filter. 

List of 

queues. 

Personal 
queue with 
calls waiting 

for you. 

Administer 

Queues. 
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Filter Description 

All queues Show all queues in your system. 

My queues Show only the queues from which you can receive calls. Both subscribed and 
unsubscribed queues are displayed.  

Subscribed 
queues 

Show only your subscribed queues, i.e. those from which you receive calls. 
 
When you are Standby, this filter shows the queues you will receive calls from, if 
the call situation becomes critical.  

 
 

Please note: Some queue filters might be disabled. 

If you cannot see some of the filters mentioned above, they might have been disabled by your 
system administrator.  
 

2.3.1.2 Personal Queues 

Your personal queue shows how many calls are waiting specifically for you. Calls are placed in this 
queue if another agent transfers a call to you, if one of your transfers fails, if your system is configured 
to offer new calls this way or if someone calls your agent phone. When you have calls waiting in your 
personal queue, you will not receive calls from other queues before all your waiting calls have been 
answered. If you are viewing the Agents or Calls tab, when calls are waiting in your personal queue, the 
top of the Queues tab will turn orange. 

2.3.1.3 Queue Information 

The Queues tab shows you graphical representations of queues and the agents subscribing to them. 
The arrows next to each queue show whether you receive calls from the queue. If you change your 
status to Inactive, the arrow colors will remain. This way, you know from which queues you will receive 
calls, when you change back to Active or Standby. 
 

 
 
 
 
 

 
 
 
 
 
 
 

The information displayed for each queue in the Queues tab. 
 

 

Name of the queue. 

Number of agents subscribing to the 
queue. The number in parentheses 
is the number of Standby agents, 

who have not been activated. 

Number of calls 

in the queue.  

Arrow indicating whether you receive calls from the 
queue. You receive calls from queues with black arrows. 

Graphical representation 

of the calls in queue. 

Graphical representation of the agents 
subscribing to the queue. If many agents 
are subscribing, you will see an agent 

summary instead of individual agent icons. 
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As long as the Standby agents on a queue have not been activated, they will be shown as orange 
squares. Once the Standby agents become needed and are activated, they will no longer differ from 
regular agents. 
 

 
 
 
 
 

     
 
 
 
 
 
 

A queue before and after Standby agents have been activated, i.e. they start receiving calls. In 
this case, the standby agents were activated since the only active agent went offline. 

 

 

If you wish to see which agents are handling a queue, hover 
the cursor over the colored squares representing the agents. 
A list of names will pop up, showing who are handling the 
queue and which status each agent has.  
 
If an agent has provided a reason to change his or her status 
to Inactive or Standby, the reason will be written in 
parentheses after the agent’s name. 

 

 
 

Hover the cursor over the agent 
icons to view more information. 

 

2.3.1.4 Administer Queues 

When you open the window Administer Queues from the 
bottom of the Queues tab, you can choose from which 

queues you want to receive calls. You will only receive calls 
from the queues you check and only these queues will be 
shown when you use the Subscribed queues filter. The 
queues you do not check are still shown with the My queues 

filter. That way you can keep monitoring the queues and their 
calls. 
 
Please note that your administrator may have chosen to make 
you permanently Standby on one or several queues. Those 
queues are not visible in the Administer Queues window and 
you cannot stop receiving calls from them.  
 
If you cannot see the Administer Queues option at the bottom 
of the Queues tab, it may have been removed by your 
administrator. 

 

 
 

The Administer Queues window. 
 

If you are Standby on a queue and become activated, the arrow will change 

color from gray to black, indicating that you now receive calls from the queue. 

Until Standby agents are activated on a 
queue, their number is shown in 
parentheses and with orange squares. 

When Standby agents are activated, they 
are shown among the other agents on the 

queue. 
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2.3.2 Agents 

The Agents tab gives an overview of all 

online agents. You can see the status and 
personal queue for each agent. The 
different status icons are described in 
Appendix A. 
 
Similar to the Queues tab, you can choose 
which agents you want to view, by 
choosing a filter at the top of the tab. 
 
 

 
 
 
 
 

 

 
 

The Agents tab. 
 

2.3.2.1 Agent Filters 

The agent filtration is based on whether they subscribe to some of your queues or on how active the 
agents are. 
 

Filter Description 

All Show all online agents, i.e. agents who are Active, Standby, or Inactive. 

Active Show all online agents who are Active or Standby. 

Subscribed to my 
queues 

Show all online agents who subscribe to at least one of your subscribed 
queues. 

Subscribed to my 
queues – Active 

Show all online agents who are Active or Standby and subscribe to at least 

one of your subscribed queues. 

Inactive Show all online agents who are Inactive. 

 
 

Please note: Some agent filters might be deactivated. 

If you cannot see some of the filters mentioned above, your system administrator might have 
deactivated them. 
 

2.3.3 Calls 

The Calls tab shows information about 

your current call and some statistics on 
the calls you have handled today. 
 
When you do not have any calls, you will 
only see the call statistics in the tab. 
 
Read more about call handling in chapter 
3. 

 
 
 
 
 

 

 
 

The Calls tab  
(with no active calls). 

 

Choose filter. 

Your personal 

queue. 

List of agents, 
their status, 
and their 

personal calls. 

When you do 
not have a call, 
you can only 
see the call 

statistics. 
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2.4 Notification Bar 

The notification bar is where your company can publish short, internal messages regarding your daily 
work. You find the notification bar at the bottom of the Contact Center Window. The bar shows one 
notification per line. If there are more than two notifications, the bar will cycle through all messages until 
the end of the list is reached, which is marked by three small squares. The notifications will then be 
repeated. You can click the notification bar to manually cycle through the messages, if you do not want 
to wait for it to change. If you do not want to see any messages, you can click the minus icon on the 
right to collapse the notification bar. If new messages arrive while the bar is collapsed, it will 
automatically expand. 
 

 
 
 
 
 

       
 

Notification bar at the bottom of the Contact Center Window. 
 

 

No messages. Notification bar 

collapsed. 

At least three messages. 

The last one is shown. 
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3.1 The Call Process 

Incoming calls to company queues are automatically distributed to the agents. From the moment the 
agent receives a call, call handling can be divided into the four phases described below. You will find a 
thorough description of all phases in the following sections. 
 

 

In order to receive a call, 
your status must be 
Active or Standby and 
you must be idle. 
 
You can only receive calls 
when you are not already 
handling a call.  

 

1) Wait for a call to be 
distributed to you and 
appears in the Calls tab 

 
When you receive a call, 
the Calls tab will expand. 
Click the Answer button in 
the tab to answer the call.  
 
See section 3.1.1 for 
more. 

 

2) Handle the call 

 
Use the top of the Contact 
Center Window to handle 
the call, e.g. put it on 
hold, or hang up.  
 
When you finish a call, 
you will be asked to either 
provide reason codes 
(phase 3) or go into 
Wrapup (phase 4).  
 
See section 3.1.2 for 
more. 

 

3) Provide reason codes 

 
Reason codes let your 
company keep track of 
which kind of calls you 
handle for statistical 
purposes. 
 
Choose one or more 
reason codes and click 
Finish to go into Wrapup. 
 
See section 3.1.3 for 
more. 

 

4) Wrapup 

 
Wrapup is a short amount 
of time after a call, where 
you will not receive any 
new calls. This allows you 
to finish any call related 
tasks before a new call is 
offered. 
 
See section 3.1.4 for 
more. 

 

After Wrapup 
 
After your Wrapup time, 
your status will return to 
idle and you can receive 
calls again.  
 

 

3 Call Handling 
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3.1.1 Receiving and Answering Calls 

When you receive a call, the Calls tab will automatically expand and a countdown starts in the upper 
part of the Contact Center Window. The countdown shows how much time you have to answer the 
offered call. If you do not answer the call in time, your status will change to Unreachable (section 2.1.3). 
You answer the call by clicking Answer if it is an incoming call or Call if you have been offered a callback 

or a dialout (section 3.2.1). 
 

 

 
 

A call is waiting to be answered in the Calls tab. 
 

3.1.2 Call Handling 

Once you answer a call, your options to handle it will change as shown below. 
 

 

 
 

A call you are currently handling. 
 

 

View the call's history or add a 
note to it. If there is an icon on 
the button (as illustrated in this 
image), there is already a note 

you should read (section 3.1.5). 

Click Ext. Offer to restart the 

countdown. Note that you can 

only click the button once. Click Answer to answer the 
call or Call, if it is a callback or 

dialout (section 3.2.1) 

Click Lookup to find the 

customer in your systems (this 

feature might be disabled).  

The countdown shows how 
much time you have to answer 

the call. 

Call information. View the 
name and number of the caller 
as well as waiting time, queue 

and, if transferred, first queue. 

View your active calls and 
talking time. 

Click Hang Up to end the 

talking call.  

Put a call on hold. If you have 
two ongoing calls, the button 
changes to Toggle instead of 
Hold and will let you toggle 

between the two calls.  

Record the conversation (you 
can only see this button if the 
feature is available in your 

setup).  

Enter a phone number and click 
Dial or Transfer depending on 

whether you want to transfer the 
call unattended or attended 

(section 3.6.9 and 3.6.10). 
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The buttons you may come across during call handling are described below:  
 

 
Use the Dial button to make an outgoing call e.g. when making an attended 
transfer (section 3.6.9). When you click Dial, you will call the number in the phone 

number field (section 3.6.3). 

 
If you need to enter digits, e.g. during an outgoing call, you can use the Numeric 
Keypad. You open it by clicking the button to the left of the phone number field. 

 

 

 

Click the Hold button to put a call on hold. If you have a call on hold, the button 
changes to Resume and will resume the call you put on hold. If you have two 
active calls, the button changes to Toggle instead. If you click Toggle, you will 

toggle between your two calls, putting the active call on hold and resuming the 
other call. 

 
To finish your conversation, click Hang Up to end the talking call. It is not possible 

to end calls on hold. 

 
Use the Transfer button to transfer a talking call to another agent or queue. The 

button works differently depending on whether you have one or two active calls.  
 
When you have one active incoming call, you can transfer it to a number, an 
agent from the Agents tab or a queue from the Queues tab. You can also select 
a person in the Time component instead of entering a phone number. If the 
person you selected has created a forwarding, you will be asked whether you 
want to break through. If you choose “yes”, you will transfer to the number you 
chose in the Time component instead of following the forwarding.  
 
If you make an outgoing call during an incoming call, the Transfer button will 
instead connect your two calls. Once you have transferred the calls, you will no 
longer participate in any of the conversations and enter wrapup. 

 

 

If the feature is available to you, you can record a call by clicking the Record 
button placed between the Hold and Hang Up buttons. While recording, the red 

button icon changes to an animation, indicating that the call is being recorded. If 
you make an outgoing call while recording an incoming call, the outgoing call will 
also be recorded. When you end the last active call, the recording automatically 
stops. Depending on your configuration, a window might appear in which you can 
explain why you recorded the call and discard or save the recording. 

3.1.3 Reason Codes 

After ending a call, you may be asked to provide reason codes. Your company may use this feature for 
statistics regarding which kind of calls you receive. Whether you have to provide reason codes, and how 
many you can choose, depends on the setup of the queue from which the call came.  
 
How you provide reason codes depends on: 
1. Whether you can select several reason codes or only select one. 
2. Whether you can skip reason codes or must choose. 
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This gives four different ways to provide reason codes. All four methods for providing reason codes are 
covered in the images below. Once you have finished selecting, click the Finish button at the bottom of 

the tab to start Wrapup. If you answered a call from a queue without any reason codes at all, you will 
immediately start Wrapup once the call ends (section 3.1.4). 
 

 
 

       
 

The four different ways you can provide reason codes. 
 

3.1.4 Wrapup 

Once you have ended a call and provided reason codes (if required), you will go into Wrapup. In Wrapup, 
you will not receive any new calls. If you have any remaining tasks related to the previous call you just 
handled, Wrapup gives you a chance to wrap these up.  
 
In Wrapup, the two buttons Extend and End will be available in the upper part of the Contact Center 

Window. Click Extend if you need more time in Wrapup before your status changes back to idle (please 
note that you can only click the Extend button once). Click End if you are ready to receive new calls and 
want to end your Wrapup.  
 

When you must 
select either one or 
no reason code, you 
get an additional 
option at the top of 
the list called No 

reason code. 

When you can 
select several 
reason codes but 
must select at least 
one, you cannot 
click Finish without 

selecting. 

When you can 
select zero or 
several reason 
codes, you can 
click Finish without 

having made a 

selection. 

When you must 
select exactly 
one reason code, 
the reason code 
at the top is 
selected by 

default. 
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Contact Center Window during Wrapup. 
 

3.1.5 History and Notes 

During a call, the History button is available in the Calls tab. Click the button to open a window with 

information about the call.  
 
In the top of the window, you can see which agents have handled previous calls from the customer and 
which number they transferred the call to if the call was transferred. If another agent handled the call 
before you, he or she may have attached a note, which will be displayed in the bottom half of the window. 
If several notes are attached to the call, the newest will be highlighted in green. If you want to view the 
full call history, including when the call was queued or offered to an agent, click the Show History button 
to open a browser window with the available information. 
 

 

 
 

Click the History button during a call to open the History window. 
 

 

View your remaining Wrapup 

time. 

Click End to end your 

Wrapup time and receive 
new calls.  

Extend your 

Wrapup time.  

Notes 
attached to 

this call. 

Attach your 
own note to the 
call. Enter your 
note and close 
the window 
when you are 
done. If you 
want to remove 
your note, 
simply delete 
what you 

entered. 

View the last 
three agents 
who handled 
calls from this 
customer and 
any transfers 

they made.  

Open a 
browser 
window with 

the call history. 
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3.2 Types of Calls 

3.2.1 Calls Distributed to You 

The system can distribute three kinds of calls to you: Incoming calls, callbacks and dialouts. When you 
receive a call, it will appear in the Calls tab. You cannot receive new calls until you have finished the 

one you are currently handling.  
 

Type of call Description 

Incoming call The customer has called a queue and is waiting for an agent to answer the call. 
If you have enabled a personal pickup announcement, it will be played 
immediately after you answer the call, before your conversation starts. 

Callback Instead of waiting in queue, customers may choose to be called back when it is 
their turn. If you are offered a callback, you will see the buttons Call and Play 

instead of the Answer button. Click the Call button to call the customer. Click the 
Play button if the customer has left a recorded voice message. Once the call 
ends, you need to either finish or postpone the callback.  

Dialout A dialout is similar to (and resembles) a callback. The difference between the 
two is how they are initiated: A callback is initiated by a customer while a dialout 
is initiated by your company. 
 
Dialouts are useful if you have to call many different customers. Instead of giving 
you a long list of phone numbers to call, your company can create dialouts from 
this list. In this way, you do not have to spend time on typing every single phone 
number – you just click Call when you receive a dialout.  

 
To ensure you know the purpose of calling the customer, dialouts should either 
be coordinated in advance or have a note attached with the information you 
need to know before calling. 

 

 
 
 
 
 

       
 

The three types of call, the system can distribute to you. 
From the left: A regular incoming call, a callback, and a dialout. 

 

Use the number prefix to differ between callbacks and dialouts. 

The prefix will be either Callback or Dialout. 
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3.2.2 Outgoing Calls 

You can initiate an outgoing call in three 
ways: 1) Enter a number in the phone 
number field in the Contact Center 
Window, 2) select an agent in the Agents 
tab, or 3) select a user in the Time 
component in the Time window. Click Dial 

to dial the number. 
 
If a user from the Time component has 
more than one phone number registered, 
e.g. an office phone number and a mobile 
number, click the number you want to call.  
 
If you enter a number in the phone number 
field, remember to include prefixed num-
bers or characters such as “0”, if this is 
required by your system.  
 
You can make outgoing calls while 
handling an incoming call, but you cannot 
receive incoming calls while you are 
handling an outgoing call. You can only 
make one outgoing call at a time.  

 
 
 
 
 

 

 
 

The Calls tab with two calls. 
 

 

 
 
 
 
 
 
 

       
 

The three different ways you can make an outgoing call. 
 

3.3 Callbacks and Dialouts 

You will only receive callbacks and dialouts if these features are used by your company. As mentioned 
in section 3.2.1, callbacks are initiated by customers who want to be called back instead of waiting the 
queue while dialouts are initiated by your company who wants you to call specific customers. 
 

An outgoing 
call is always 
shown in the 
bottom part of 
the Calls tab, 
below any 

incoming call.  

Option 1: 
Enter a phone number in 
the phone number field 

and click Dial. 

Option 3: 
Select a phone number in 
the Time component and 

click Dial. 

Option 2: 
Select an agent in the 

Agents tab and click Dial. 

On hold 

(gray text)  

Talking 

(black text)  
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Both callbacks and dialouts are handled almost the same way as regular incoming calls. When you 
receive a callback or a dialout, you will see the buttons Call and Play instead of the Answer button in 
the Calls tab. You will also see a Finish button in the upper part of the Contact Center Window.  

 
The Play button is only enabled for callbacks and only in cases where the customer has left a recorded 
message. Click Call to call the customer or click Finish if calling the customer is not necessary or the 

call needs to be postponed.  
 
After a call, or if you click Finish, you have two options in the Calls tab: You can finish the callback or 

postpone the callback, where the latter will reschedule the callback for another time. 
 
In order to finish your callback or dialout, you must choose the option which best describes the call. The 
available options are always Success, Busy or No answer. You may also be asked to provide reason 
codes below these three options (section 3.1.3). Click Finish at the bottom of the Calls tab to finish your 

callback or dialout. 
 
In order to postpone your callback or dialout, select either Postpone – Busy or Postpone – No answer 

and select a duration. You can choose between predefined options or manually enter a date and time. 
Click Finish at the bottom of the Calls tab to postpone your callback or dialout. 

 

 

                                
 

How you finish or postpone a callback. The same options are available for dialouts. 
 

 

Click 
Finish to 

end or 
postpone 
your 
callback 
without 
calling the 
customer.  

If the Play button is 

enabled, the 
customer has left a 
recorded voice 
message you can 
listen to (callbacks 

only). 

Call the 

customer. 

Select Success, 
Busy or No answer 

to finish your 
callback. You may 
be asked to provide 

reason codes. 

Select Postpone – 
Busy or Postpone 
– No answer in 

order to postpone 
your callback and 
choose how long 
you want to 

postpone it. 
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3.4 Call History 

In the Contact Center Window, you can 
open a simple history of your latest 
incoming and outgoing calls by clicking 
the small arrow in the right side of the 
phone number field.  
 
For a thorough call history, go to the File 
menu in the Time window and select Call 
History. 

 
 
 
 
 

 

 
 

The phone number field. 
 

 
In the left side of the Call History window, you can choose which day you want to view. In the right side, 
you can see information about a highlighted call and four buttons. You can click Copy all or Copy 
number to copy that information and insert it somewhere else e.g. in emails. Click Call to call the 
selected number. The Event history button will open more call details, e.g. when the call was queued, 

or when you answered the call. 
 

 

 
 

You access the Call History window from the File menu in the Time window. 
 

3.5 View Shortcuts 

Shortcuts may be available for the call buttons. To view them, you can either: 
1. Open the Help menu in the top of the Time window and choose Shortcuts. 

2. Press and hold your keyboard's right Ctrl key (this feature can be turned on or off in the settings). 
 
The Shortcuts window contains all the shortcuts already configured and available in the application. If 

you press and hold the Ctrl key in the right side of your keyboard, you can view the shortcut for every 
single call button below the button, assuming a shortcut exists and that the feature has been enabled in 
your settings. 

Click the arrow in 
the phone number 
field to see a simple 

call history. 
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3.6 Call Handling Examples 

3.6.1 Answer a Call 

 

       
 

3.6.2 End a Call and Provide Reason Codes 

 

                     
 

1) Ensure you are 
idle and wait for a 

call to be offered. 

2) Click 
Answer when 

you receive a 
call. 

Use the buttons in 
the top of the 
Contact Center 
Window to handle 

the call. 

1) Click 

Hang Up. 2) Select a 
reason code and 

click Finish. 

3) Extend or 
End Wrapup as 

necessary. 
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3.6.3 Dial a Number 

 

     
 

 
If outgoing calls must be prefixed with numbers or character, such as “0”, due to system requirements, 
remember to enter these before the phone number you wish to call.  

3.6.4 Call Another Agent 

 

     
 

 
 

Please note: You may not be able to call an agent. 

An agent's phone type determines whether you can call that agent. Because of this, not all agents 
can be called.  
 

 

1) Enter a 
number 
and click 

Dial. 
2) Click 
Hang Up 

to end the 

call. 

1) Choose 

an agent. 

3) Click 
Hang Up 

to end the 

call. 2) Click 

Dial. 
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3.6.5 Put a Call on Hold 

 

     
 

3.6.6 Handle a Callback with a Recorded Message 

 

       
 

 

2) Click 
Resume 

to resume 

the call. 

1) Click 
the Hold 

button. 

1) Click Play to listen to 

the customer's recorded 
message. This can only 
be done before calling 

the customer.  

2) Click 

Call. 

Use the buttons in 
the top of the 
Contact Center 
Window to handle 

the call. 
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3.6.7 Finish a Callback and Provide Reason Codes 

 

                       
 

3.6.8 Postpone a Callback without Calling the Customer 

 

                       
 

 

1) Click 

Hang Up. 
3) Select a 
reason 

code. 

5) Extend or 
End Wrapup as 

needed. 

2) Choose 
Success, Busy 

or No answer. 

1) Click 
Finish when 

a callback is 
offered. 

4) Click 

Finish. 

2) Select  
Postpone – Busy or 

Postpone – No answer. 

3) Select a 
duration and 

click Finish. 



24  |  ZYLINC CONTACT CENTER  -  3: Call Handling  

  
  
  
  
  

 

Copyright Zylinc 2016. All rights reserved. 
 

 

3.6.9 Unattended Transfer 

 

 
 

3.6.10 Attended Transfer 

 

     
 

1) Enter a number in the 
phone number field during 
an incoming call. 
 
You may also choose an 
agent from the Agents tab, 
a queue from the Queues 
tab or a person from the 

Time component.  

2) Click Transfer to transfer 

your incoming call to the 
number you entered or 

selected. 

1) Enter a number in the 
phone number field during 
your incoming call and click 
Dial. 

 
You may also choose an 
agent from the Agents tab 
or a person from the Time 
component. 

2) Click 
Transfer to 

transfer your 
talking call to 
your call on 

hold. 
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3.6.11 Attach Note and Transfer Call to Another Agent 

 

       
 
 
 
 
 
 

3.6.12 Record a Call  

 

       
 

 

1) Click 

History. 

2) Write your note 
in the note field. 
Click Close once 

you are done. 

3) Choose an 
agent (only agents 

can view notes). 

4) Click 

Transfer. 

1) Click the 
Record 

button. 

2) Click 

Hang up. 

3) If this window appears 
once you hang up, 
explain why you recorded 

the call and click Save. 
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4.1 Headset 

If you are using a headset, you may have access to additional settings, depending on your headset and 
setup.  
 
In order to use your headset with Zylinc Contact Center, open the Actions menu in the Time window, go 
to Sound Devices, and ensure your headset is checked. If you have more than one headset connected, 
check the one you wish to use.  
 
If you wish to use different headsets for microphone and speaker, open Settings from the File menu. 
Open the option Interface, then Audio and finally Devices to set this up. 

4.1.1 Jabra and Plantronics 

If your headset is a Jabra or Plantronics headset, you will have even more settings available. Open 
Settings from the File menu, and click Interface, Audio, and Headset to adjust these settings. The 

settings available depend on the brand and model. 
 
 
 
 
 
 
 

4 Settings 
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The icons you can find in the Queues and Agents tabs in the Contact Center Window are described 
below. 

A.1 Icons in the Queues Tab 

 
 
 
 

 
 
 
 
 

A queue and its icons in the Queues tab. 
 

A.1.1 Whether You Receive Calls 

 You do not receive calls from this queue 

 You receive calls from this queue 

A.1.2 Calls 

 The call's waiting time has not exceeded the service goal of the queue 

 The call's waiting time has exceeded the service goal of the queue 

A.1.3 Agents 

 The agent’s status is Idle 

 The agent’s status is Busy 

 The agent is in Wrapup 

 The agent is in Standby mode 

 The agent’s status is Inactive 

 The agent’s status is Unreachable 

 
 
 
 
 
 

Appendix A: Queue and Agent Icons 

Whether you receive calls from the queue. Calls 

Agents 
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A.2 Icons in the Agents Tab 

 The agent’s status is Idle 

 The agent’s status is Busy 

 The agent is in Wrapup 

 The agent is in Standby mode 

 The agent’s status is Inactive 

 The agent’s status is Unreachable 

 


